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Copyright ©  2024 Pixelhue Technology Ltd. All Rights Reserved. 

No part of this document may be copied, reproduced, extracted or transmitted in any form or by any 
means without the prior written consent of Pixelhue Technology Ltd (hereinafter referred to as 
PIXELHUE). 

Trademarks 

 is a trademark of Pixelhue Technology Ltd. 

Brand and product names mentioned in this manual may be trademarks, registered trademarks or 
copyrights of their respective holders. 

Statement 

Thank you for choosing PIXELHUE products. This document is intended to help you understand and use 
the products. PIXELHUE may make improvements and/or changes to this document at any time and 
without notice. If you experience any problems in use or have any suggestions, please contact us via 
the contact information given in this document. We will do our best to solve any issues, as well as 
evaluate and implement any suggestions. 

This document could contain technical inaccuracies or typographical errors. Changes are periodically 
made to the information in this document; these changes are incorporated in new editions of this 
document. 

The latest edition of user manuals can be downloaded from the official website of PIXELHUE.  
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1 General 

Overview 

 About This Manual 

 Symbols and Pictures 
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About This Manual  

This user manual guides you how to use our software. This manual is designed to be 
a reference for your daily use of our product. 

 Note  

Always check for the latest version of all documents at www.pixelhue.com.  

Symbols and Pictures  

Symbol Overview 

  Danger Indicates a hazard with a high level of risk, which if not avoided, 
will result in death or serious injury. 

  Warning Indicates a hazard with a medium or low level of risk, which if 
not avoided, could result in minor or moderate injury. 

  Caution Indicates a potentially hazardous situation, which if not avoided, 
could result in equipment damage, data loss, performance 
degradation, or unexpected results. 

  
Note Provides additional information to emphasize or supplement 

important points of the main text. 

Picture Overview 

Images and pictures given in this manual are used for illustration purposes only. The 
actual product may vary due to product enhancement. The content of the images can 
be slightly different from reality, such as device types, installed modules, form and 
position of software windows on the screen. 

http://www.pixelhue.com/
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2 Software Installation 

About This Chapter 

This chapter is designed to guide you to the installation of the software. 

Overview 

 Software Installation 

 Software Licensing 
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Software Installation 

Requirements of Software Operating Environment 

To better use Pilot MS3, the computer where Pilot MS3 is installed needs to meet the 
minimum configurations for the operating environment as follows: 

 CPU: 9th Generation Intel® Core™ i7 or later 

 RAM: 16GB or greater DDR4 2666 

 Graphics card: NVIDIA P2200 (or later) or AMD W5100 (or later) discrete graphics 
card recommended 

 HD space: 512G or larger SSD 

 OS: Windows 10 Pro (64-bit) 

Installation Procedure 

 Note  

The following installation pictures are for illustration purposes only. The actual pictures may vary.  

 Double click the program file (Pilot MS3.exe) to start the installation wizard. 

 Select I accept the agreement. 

 License agreement 

 

 Click Browse to select the folder where the software will be installed. 
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 Select installation path  

 

 Click Next to enter the Select Start Menu Folder page. 

 Select start menu folder 

 

 Click Browse or enter the folder name directly to select a folder for the start menu. 

 Click Next to enter the Select Additional Tasks page. 

Check the box next to Create a desktop shortcut to add the Pilot MS3 shortcut icon 
on the desktop. 
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 Additional tasks 

 

 Click Next to enter the Ready to Install page. 

 Installation confirmation 

 

 Click Install to enter the automatic installation page. 
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 Automatic installation 

 

 After the software installation is finished, click Finish. 

The system will exit the software setup page and start the Pilot MS3 software 
automatically. 

 Installation completed 

 

After the program is successfully installed, two programs (Pilot MS3 and NDI Sender) 
appear on your desktop. 

 Pilot MS3: Video playback program 
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 NDI Sender: Provides NDI inputs for Pilot MS3 

 Notes  

 It is recommended you turn off the anti-virus software and firewall in advance. 

 If any security alert from anti- or firewall appears during installation, choose to allow the 
installation. 

 If the software prompts you to restart after the installation, it is recommended you restart the 
software in time. 

 

Software Licensing 

After Pilot MS3 is started, the software automatically detects the presence of an 
authorization dongle. If a dongle is detected, the Pilot MS3 user interface will be 
displayed normally; if not, the following window will be displayed and guide you 
through obtaining the authorization dongle. 

 Dongle detection 

 

You can license your software via the following two methods. 

 Purchase an authorization dongle from your sales. 

1. Insert the authorization dongle into the USB connector of the computer, and start 
the Pilot MS3 software. 

2. Copy the authorization ID file in the USB drive that comes with the authorization 
dongle to your computer. 

3. On the authorization user interface, click Import at the upper right corner and 
select the authorization ID file. 
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4. Click Open to complete the importing. 

 Take a clear picture of the QR code and send it to your sales to obtain the 
registration code. Enter the obtained registration code in the text box below the 
QR code, and click  to complete the authorization. 
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3 User Interface Introduction  

About This Chapter 

This chapter introduces you to the user interface of the software.  

Overview 

 Introduction 

 Change UI Layout 

 Load Layout 

 Lock User Interface 
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Introduction 

After the software is started successfully, the main user interface is shown in Figure 
3-1. The functions of each area are described in Table 3-1. 

 User interface 

 

Table 3-1 User interface descriptions 

Area Item Description 

Menu bar File Project file operations include: 

 New: Create a new project. 

 Open: Open a saved project. 

 Save: Save the current project. 

 Save As: Save the current project as a new 
project. 

 Package Project: Package the current project 
and the media files in it as an independent 
project file for easy use in future. 

Resource Manage the media files and input sources. 

 Add Local Media: Add the local media files. 

 Add Input Source: Add the network media, NDI 
screens and websites as input sources. 

 Delete All Media: Delete all the imported media 
files. 

 Delete All Inputs: Delete all the added input 
sources. 

Output Configure and manage the linked devices, screens 
and slices. 
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Area Item Description 

Window Show or hide the desired areas of the Pilot MS3 user 
interface.  

Link  Link Settings: Enter the link settings page and 
configure the backup device. 

 Update to Backup: Manually synchronize the 
data on the primary and backup devices. 

Settings Perform the system, authorization, hotkey and MIDI 
binding settings. 

Help  View the user manual. 

 View the product-related information. 

 Check for the software updates. 

Tools  Open the Transcoding Assistant tool and 
perform the needed transcoding actions. 

语言

/Language 

Switch the UI language. 

Preview area  Output: View the content of the current output program. 

 Preview: Preview the content of the next program. 

− Cut: Send the currently previewed program to the screen 
without transition effect. 

− Take: Send the currently previewed program to the screen 
with the fade transition effect. 

− If Keep is selected and the program is sent to the screen 
via Take or Cut, the program will be played from the 
current playback progress in the preview area. 

− If Keep is not selected and the program is sent to the 
screen via Take or Cut, the program will be played from 
the beginning. 
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Area Item Description 

Editing area  Use layers to configure the output according to the on-site 
screen pattern. 

 Preview the output image. 

 : Adjust the output image brightness. The value ranges 
from –50 to + 50 and defaults to 0. 

 : Adjust the output volume. The value ranges from 0 to 100 

and defaults to 50. Click  to turn off the output audio. 

 : After selecting a layer or slice in the editing area, click this 
icon to capture the current frame of the selected layer or slice 
and add the captured image to the media library. 

 : Make the selected layer fill the screen area loaded by the 
output connectors where the layer is located and crosses. 

 : When the output image is moved out of the visible area, 
click this icon to restore the screen to the origin. 

 : Zoom in the editing area. 

 : Zoom out the editing area. 

Layer and 
program editing 
area 

 Add, control and mosaic the layers. 

 Edit, group and play the layers. 

Playback 
control area 

Control the playback of the programs or layers in the program. 

Media library 
and properties 
area 

Media 
Library 

Manage the media files. 

 Add the local media files. 

 Create folders to manage the media files 
efficiently. 

 Delete, replace or rename the media file. 

Input 
Sources 

Manage the input sources. 

 Add the network media, NDI screens and 
websites as input sources. 

 Delete the input sources. 

 Preview the input sources. 

 Enable or disable the preview of acquisition card 
sources. 

Properties Edit the layer or program properties. 

Others  Event 
Controller 

Enable or disable the event controller control. 

MIDI Open the MIDI Connection Settings window and 
connect the MIDI devices. 

 The output connection has been established. Click 
the button to disconnect the output. 
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Area Item Description 

 The output has been disconnected. Click the button 
to regain the connection. 

/   : Output normally. 

 : Fade to black. 

Click , the icon turns to  and the output 
fades to black. 

Click , the icon turns to  and the output 
displays image as usual. 

When the slider block is at the leftmost, the output is 
black; when the slider block is at the rightmost, the 
output is normal. 

The default FTB duration is 0.5s and the value 
ranges from 0 to 5s. 

 Note  

Pressing the Ctrl + ← / → key combination allows you to switch the display screen of the 
software main user interface.  

Change UI Layout 

Pilot MS3 allows you to adjust the user interface layout according to your using 
habits. You can save and load the adjusted layout. 

 Click  at the top right corner of the target area to unlock this area. 

The icon descriptions are as follows: 

  (highlighted): The area is locked and you cannot adjust its size and position.  

  (grayed out): The area is unlocked. Move the cursor to the edge of the area 
and then click and drag the edge to adjust its size.   

 Move the cursor to any edge of an area. When the cursor turns into a double-sided 
arrow, click and drag the mouse to change the area size. 

 Move the cursor to the title bar of an area, and click and drag the mouse to change 
the area position. 

 Click  at the top right of the user interface to save the adjusted layout. 
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 Save layout 

 

 Enter a layout name. 

The layout name is unique and it is recommended you set a name that is easy to 
recognize. 

 Click Save to save the layout. 

Load Layout 

When the interface layout has been adjusted by others, you can load your preferred 
layout simply by using this function, instead of adjusting it area by area. 

 Click  at the top right of the user interface to open the layout loading window. 

 Load layout 

 

 Select the desired layout from the list on the left. 

 Click Load to load the layout. 

You can also perform the following operations: 

 Delete: Delete the selected layout from the layout list. 

 Restore Default: Restore the current interface layout to the default style. 

 Cancel: Cancel the layout loading and exit the layout loading interface. 
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Lock User Interface 

If you do not want others to operate the software when you are away, just simply use 
this function to lock the software interface. 

 Click  at the top right of the user interface to open the UI locking window. 

 Lock user interface 

 

 Enter a password. 

 Set the opacity for the locking interface. 

100% is completely opaque. At this time, the editing interface is completely invisible 
and only the lock screen background can be seen. 

 [Optional] Click Change next to Background to select a picture to be displayed on the 
locking interface. 

 Click Lock to complete the locking settings and lock the interface. 

 Notes  

 The locking password and background are for one-time use only. When you want to lock the 
interface for a second time, please set the password and background again. 

 To unlock the user interface, just enter your password click  to show the Pilot MS3 
interface. 
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4 Project 

About This Chapter 

This chapter guides you on how to add media files, edit programs, set program 
playback sequence and media properties, save configuration data as an independent 
project file for future use and more.   

Overview 

 Create New Projects 

 Manage Media 

 Manage Layers 

 Build Application Environment 

 Produce Programs 

 Playback Control  

 Save Projects 
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Create New Projects 
There are three methods provided for you to create a new project. 

 After Pilot MS3 is started successfully, click New on the startup interface and 
select the save path for the new project, and finally click Save. The system will 
automatically create a project file. 

 Go to File > New, select the save path for the new project and click Save to create 
a new project. 

 Click  below the menu bar to create a new project. 

Manage Media 
Pilot MS3 supports pictures, videos, audio media files and website inputs. 

The supported media formats are as follows: 

 Video: avi, asf, wmv, flv, mkv, mov, 3g, mp4, mpg, mpeg, ts, m4v 

 Picture: jpg, bmp, gif, mif, miff, png, wmf, jpeg, ico, pic 

 Audio: wav, mp3, wma, ape, aac, flac, ogg, dts, amr, alac 

 Office files: ppt, pptx 

 Notes 

Recommended video coding formats: 

 4K < resolutions ≤ 8K: H.265 (HEVC) or VP9 recommended 

 Resolutions ≤ 4K: H.264 (AVC) recommended 
 

For a better image quality experience, the following video bitrates are recommended. 

Recommended video bitrates for SDR uploads: 

Type Video Bitrate Standard Frame Rate 

(24 fps, 25 fps, 30 fps) 

Video Bitrate High Frame Rate  

(48 fps, 50 fps, 60 fps)  

4320 (8K) 75 to 90 Mbps 110 to 135 Mbps 

2160p (4K) 35 to 45 Mbps 53 to 68 Mbps 

1440p (2K) 16 Mbps 24 Mbps 

1080p 8 Mbps 12 Mbps 

Add Media 

Pilot MS3 supports both single media file importing and batch importing. 
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Import Files 

 Click the Media Library tab on the right pane of the user interface. 

 Right click the blank area in the Media Library area and select Add Local Media to 
open a local folder. 

 Select the target media files and click Open. Pilot MS3 will import the selected files 
to the media library automatically. 

 Importing a single file: Select the desired file and click Open to complete the 
importing. 

 Importing multiple files: Press the Shift/Ctrl key, select the desired files, and click 
Open to complete the importing. 

Import Folders 

There are three methods provided for you to import a folder. 

 Import folder 

 Right click the blank area in the Media Library area and select Add Local Folder to 
open a local folder. 

 Select the desired folder where the media files are stored, and click Open. 

The system will automatically import the media files in the target folder with their 
original names to the media library. 

 Replace folder 

 Right click the blank area in the Media Library area and select Add Folder. The 
system will automatically create a new folder. 

 Right click the folder and select Replace in the context menu. 

 Select the desired folder from the displayed dialog box. 

 Click Select Folder and the system will automatically import the media files in the 
target folder with their original names to the media library. 

Edit Media 

Media Optimization 

When the imported media or video resolutions are inconsistent, or the imported 
media resolution exceeds the processing capability of Pilot MS3, to facilitate future 
use, you can change the file resolution in advance by using this function. 

 Note  

Only the videos and .jpg pictures can be optimized to even resolutions only.  

 Select the picture or video that needs to be optimized from Media Library. 

 Right click the file and select Media Optimization in the context menu. 

 Set the desired parameters for the optimization. 
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 Media optimization 

 

If Lock Aspect Ratio is selected, you only need to set either width or height, and the 
other parameter value will be calculated automatically according to the current 
aspect ratio of the media. 

 Click Optimize and the system will automatically optimize the selected media file. 

Create Playback Collection 

The playback collection allows you to sort and combine multiple videos or pictures 
into a new collection source. All the videos and pictures in the collection will be 
played automatically according to the set mode. 

 Right click the blank area in the Media Library area and select Create Collection to 
open the Create Collection window. 

 Playback collection 

 

 Select the desired media files in the All Media area on the left side. 
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 Click  at the top right in the All Media area to add the selected files to the 
Collection Media area on the right side. 

 Select the newly-added media in the Collection Media area. 

 Change the media properties at the bottom. 

Table 4-1 Collection media properties 

Property Description 

Duration Set how long the selected media will be played. After the playback 
ends, the next media will be played automatically. 

If the duration is not set, the video file will be played according to its 
original playback duration, and the picture file will be played for 10 
minutes by default. 

Times Set how many times the selected media will be played. 

Playback Set the media playing order in the collection media. 

 Sequential: The media in the collection will be played in 
sequence. 

 Shuffle: The media in the collection will be played randomly. 

Switching Set the transition effect when the current media starts to play or 
stops the playing. Currently, only Cut and Fade effects are supported. 

Fade in Set the time length from when the current media starts to play to 
when the media is fully displayed. 

Fade out  Set the time length from when the current media starts to stop to 
when the media is stopped. 

 Repeat Step 2 to Step 5 to complete the settings of other media in the collection. 

 Click OK to complete the collection settings. 

 Double click the collection name, and the name becomes editable. Rename the 
collection and press Enter to confirm the change. 

 Note  

After a collection is created, the default name is Playback Collection. It is recommended you give it 
a new name that is easier for you to distinguish.  

Media File Group Management 

You can create folders to classify the added media files. 

 Right click the blank area in the Media Library area and select Add Folder. The 
system will automatically create a new folder. 

 (Optional) Double click the folder to rename it. 

 Select the desired media files and drag them to the new folder. 

 Notes  

 Hold down the Shift or Ctrl key, and select the target file or multiple files in Media Library. 
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 After selecting a media file, right click it and select Insert Folder in the context menu to move 
the selected file to the newly-inserted folder. 

 

Media File Context Menu 

Right click a media to show the media file context menu. 

 Media file context menu 

 

 Add Local Media: Add new media files into the media library. 

 Media Optimization: Change the coding, quality, code rate, frame rate, audio and 
resolution settings of the videos or pictures. 

Only the videos and .jpg pictures can be optimized to even resolutions only. 

 Create Collection: Create a collection media. 

 Change Playback Collection: Change the settings of the collection media. 

 Add Local Folder: Import a folder containing media files into the media library. 

 Insert Folder: Create a new folder and move the selected media files into the 
folder. 

 Rename: Rename the selected media or collection. 

 Replace Media: Replace the currently-selected media. When the media is replaced, 
the media in the program will also be replaced synchronously. 

 Access File Location: Open the storage location of the current media. 

 Delete: Delete the current media. 

 Properties: View the media properties, such as the name, size, format and more. 

Add Input Sources 

You can add the network media, website input sources, NDI input sources and input 
sources from acquisition devices. The system automatically identifies and adds the 
input sources from acquisition devices. You can also enable or disable the 
acquisition device. 
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 Note  

When the acquisition card and its driver have been installed into the device successfully, Pilot MS3 
will automatically identify and add the acquisition card input source.  

Add Network Media 

Pilot MS3 supports adding the streaming media whose format is rtsp and rtmp as 
input sources. 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Network Media. The 
system will automatically open the network media adding window. 

 Add network media 

 

 Enter the media path in the URL text box. 

Make sure the media path begins with rtsp:// or rtmp://. 

 Click OK to complete the adding. 

Add Website Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add Webpage. The website 
page will appear as shown below. 

 Add website input sources-1 

 

 Enter an URL in the address bar. 
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 Press Enter to enter the website and select the content to be played. 

 Set the output resolution and mode of the webpage. 

Change the webpage output resolution form the first drop-down list next to Webpage 
Output at the top right. 

Change the webpage output mode form the second drop-down list next to Webpage 
Output at the top right. The supported options include Default Mode and Screenshot 
Mode. 

 Default Mode: The default webpage output mode 

 Screenshot Mode: When the webpage displays the video monitoring images, this 
mode is recommended. 

 Click ×  at the top right to close the window and finish adding the website. 

 Note  

When multiple tabs are opened, the input source displays the tab you stay on before closing.  

 Add website input sources-2 

 

 1: Preview window where you can preview the input source image, input source 
name, type and resolution 

 2: List all the input sources with their names. 

− : The added network media 

− : The added NDI input source 

− : The input sources from the acquisition device 

− : The added webpage input source 

Add NDI Input Sources 

After Pilot MS3 is successfully installed, the NDI configuration tool NDI Sender that 
comes with Pilot MS3 will be installed. After NDI Sender is enabled, Pilot MS3 will 
automatically search for all the computers whose NDI sending functions have been 
enabled in the current network segment. 

Prerequisites 

 The computer running the NDI Sender and Pilot MS3 must be on the same 
network segment. 

 Make sure the computer running the NDI Sender and Pilot MS3 can communicate 
normally. 
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NDI Settings 

 Double click the NDI Sender shortcut on the desktop to open the NDI Sender 
software. 

 NDI Sender 

 

 Set the image position and size for NDI on the computer screen. 

There are two methods to set the NDI image position and size. 

 Click Select ROI and then click and drag the mouse to select the display area you 
want to send. 

 In the Sent ROI area, you can precisely set the position and size of the sent area. 

− x: The horizontal offset from the top left corner of the sent area to the screen's 
left edge 

− y: The horizontal offset from the top left corner of the sent area to the screen's 
top edge 

− w: The horizontal width of the sent area 

− h: The vertical height of the sent area 

After the settings, you can click Show ROI to see the image position and image size 
you have set. 

 Enter an NDI name. 

 Select the screen you want to send if there are multiple computer screens. 

 Enter the frame rate of the NDI image. The default value is 25. 

 Click Start to complete the NDI Sender settings. 

Add NDI Input Sources 

 Click the Input Sources tab on the right pane of the user interface. 

 Right click the blank area and go to Add Input Source > Add NDI Screen. The system 
will automatically search the current network segment for all the NDI-enabled devices 
and then show you the NDI list. 
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 NDI list 

 

 Select the NDI sources from the NDI list. 

 Select NDI sources 

 

 Enter an NDI name. 

After the name is changed here, the new name will be displayed under the Input 
Sources tab. 

 Click OK to complete adding an NDI source. 

Website Input Source Menu 

Right click an input source under the Input Sources tab to show the website input 
source menu. 

 Website input source menu 

 

 Add Input Source: Add the network media, NDI screen or webpage. 

 Rename: Change the input source name. 

 Set Loop Interval: Set how long the input source is previewed in the preview area. 
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 Stop Loop Preview: Stop loop preview of the current input source in the preview 
area. 

 Restore Loop Preview: Perform loop preview of all the input sources in the preview 
area. 

 Delete: Delete the current input source. 

 Properties: View the relevant information of the input source, including the name, 
type, network address, resolution and frame rate. 

 Click  at the bottom right of the acquisition card to select whether to add the 
sources from the acquisition device.   

Manage Layers 

Add Layers 

The layer is a container where you store the media file of a program. Before you edit 
the program, please add the layers and add the media files into the layers first. 

 Click + at the top left in the Plan area to add a layer. 

The new layer will be added to each program. 

 Change the layer position in the Editing Area to arrange the output slices and avoid 
overlapping perfectly. 

 Slice position 

 

 Select a layer and click the Properties tab on the right pane to show the layer 
properties. 

 Configure the layer-related properties by referring to Table 4-2. 

 Notes  

 When you click and drag the layer, the purple auxiliary lines appear to help you better align the 
layers. 

 When there are too many media items, you can search for the media item in the search box 
above. 
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Layer Mosaic  

Applications 

When an image needs to be output by multiple connectors and pixel-to-pixel display 
is required, you can use this function to satisfy your needs. 

 Layer mosaic effect 

 

Operating Procedure 

 Click  at the top left in the Plan area to open the layer mosaic window. 

 Layer mosaic-1 

 

 Select and drag the layers in the Layer Layout area to the Layer Mosaic Layout area. 
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 Layer mosaic-2 

 

 Arrange the layers in the way you prefer in the Layer Mosaic Layout area. 

 Layer mosaic layout 

 

 (Optional) Change the mosaic layer name in the Properties area on the right. 

 Click Save to complete the layer mosaic. 

After the mosaic is completed, a new mosaic layer will be displayed in the Plan area. 

Set Layer Properties 

Layer Menu 

Right click a layer in the Plan area to show the layer menu as shown below. 
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 Layer menu 

 

 Rename: Change the layer name. 

 Close Image: Do not display the image of the current layer in all the programs. 

 Close Audio: Do not play the audio of the current layer in all the programs. 

 Lock layer: Lock the current layer in all the programs. After the layer is locked, the 
layer property changes will not take effect. 

 Forward/Backward: Adjust the order of the layer. 

 Insert Above: Insert a layer above the current layer row. 

 Insert Below: Insert a layer below the current layer row. 

 Clear Layer: Clear the data in the current layer. 

 Delete Layer: Clear the layer data and delete the layer. 

Layer Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface. 
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 Layer properties 

 

Table 4-2 Function descriptions 

Function Description 

Name View and change the layer name. 

Control Close Image: Do not display the image of the current layer, and only 
the audio is played. 

Size Change the layer size. 

 W: Set the layer size in the horizontal direction. 

 H: Set the layer size in the vertical direction. 

Volume Adjust the output volume of the current layer. The default value is 
100%. 

 Click  to turn off the audio. 

 Click  to reset the volume to default. 

Output Bind Select the rendering graphics card for the layer image. 

Flip Set the flipping mode of the output image. If H and V are not selected, 
the output image is displayed normally, without any flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the whole layer. 

 Proportional: The image is scaled and displayed in the layer 
according to its original aspect ratio. 

Brightness Set the overall brightness of the layer image. The value range is 0%–
100%, and it defaults to 50%. 
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Contrast Set the overall contrast of the layer image. The value range is 0%–
100%, and it defaults to 50%. 

Opacity Adjust the transparency of the output image. The value range is 0% 
(totally transparent)–100% (opaque), and it defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The value range is 0%–
100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the output image is. The 
value range is 0%–100%, and it defaults to 50%. 

Insert Above Insert a layer below the current layer row. 

Insert Below Insert a layer below the current layer row. 

Delete Layer Clear the layer data and delete the layer. 

Clear Layer Clear the data in the current layer. 

Build Application Environment 

In Pilot MS3, you can use the screens and slices to build an application environment 
according to your actual on-site needs. 

 Screen: Configure the output image displayed on the screen. 

 Slice: Configure the image output by the corresponding output connector. 

Click Output in the menu bar to open the Output Management window where you can 
relate the screens with the output connectors and change the screen position and 
sequence. 

 Output management 

 

Add Screens 

Each output connector on the discrete graphics card of the computer or server where 
Pilot MS3 is installed corresponds to a screen.  
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To synchronize output images, please refer to 8 Graphic Card Mosaic to complete 
relevant configurations. 

Add and Bind Screens Automatically 

Pilot MS3 will automatically detect the graphics card connectors and then complete 
the adding and binding of those detected connectors. All the connectors are 
displayed in the output list on the left. 

Add and Bind Screens Manually 

When you add the graphics card to the control PC or change the saved project file, 
you can add the screens manually. 

 Click Add Screen at the top left to add an output. 

 Set the screen position and size according to the screen layout in the Screen 
Properties area on the right. 

 Screen management 

 

Table 4-3 Screen properties 

Menu Description 

Resolution The resolution of the screen loaded by the connectors 

Name Change the screen name. 

Binding Set the relationship between the output connector and screen. 

HDR Set the output dynamic range. The options include SDR and HDR. 

 SDR: The output is in SDR format. 

 HDR: The output is in HDR10 format. 

Position  X: Set the horizontal distance between the top left corner of the 
screen and the top left corner of the screen editing area. 

 Y: Set the vertical distance between the top left corner of the 
screen and the top left corner of the screen editing area. 
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Size Set the screen size. 

 W: Set the screen size in the horizontal direction. 

 H: Set the screen size in the vertical direction. 

Layout When there are multiple screens, use this function to arrange the 
screens quickly. 

 : All the screens are arranged in a 1×4 pattern. 

 : The screens are arranged in a 2×2 pattern. 

 : All the screens are arranged in a 4×1 pattern. 

Enable Mark Display a sequence number on the output connector and screen, which 
helps you easily identify and adjust the output pattern. 

Disable Mark Do not display the sequence number. 

Disconnect Do not show the output image of the current screen. 

Connect Show the output image of the current screen. 

 Configure the necessary parameters in the above table to complete the screen 
configuration. 

Add Slices 

Pilot MS3 uses the slices to output the image to the LED screen. Select the desired 
image area of the layer using the slice, and then map the image to the output 
connector to complete the image construction. 

 Click Output in the menu bar to open the Output Management window. 

 Select the Slice tab. 

 Screen slice and area descriptions 

 

 Layer List: Add and delete the rectangle or polygon slices. 

 Output | Slice: Adjust the output slice positions on the screen to construct the 
desired output image. 
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 Input | Slice: Adjust the sizes and positions of the input slices, and flexibly crop the 
input image.  

 Properties: Set the properties of the output slices and input slices.  

 : Slice filling configurations 

− In the input slice area, click  to make the selected slice fill the layer. 

− In the output slice area, click  to make the selected slice fill the screen. 

 : Restore the canvas to the origin. 

 : Maximize the output slice or input slice area. 

Add Rectangle Slices 

 In the Layer List area, select the desired layer to add the slices. 

 Click + next to the layer name, and then select Rectangle Slice to add a rectangle 
slice. 

 In the output slice area, change the position and size of the output slice, as well as 
view the output image. 

 In the input slice area, change the position and size of the input slice to crop the 
input image. 

Add Polygon Slices 

 In the Layer List area, select the desired layer to add the slices. 

 Click + next to the layer name, and then select Polygon Slice to add a polygon slice. 

To add a polygon slice, you need to draw the polygon manually. During the drawing, 
please note that the sides of the polygon cannot intersect.  

 Move the cursor to the input slice area, and the cursor turns to a pen head. Click the 
polygon vertices in sequence according to the polygon style you want to draw to 
complete the polygon drawing. 

 Add polygon slices 
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 Configure the properties of the polygon slice as required. 

1. Select the polygon slice. 

2. In the Advanced area on the right pane, enable the anchor editing function. 

3. Click the desired anchor and edit the anchor in the following two ways. 

− Click and drag the anchor to change the anchor position. 

− Click the anchor, and then press the arrow keys of the keyboard to change the 
anchor position. The moving stepping can be adjusted by setting the Stepping 
value in the Advanced area. 

Application Example 

If you want to output only the panda in Layer 3, do the followings. 

 Slice application example 

 

 Under the Slice tab, select Rectangle Slice 3-1 on the left side. 

 In the input slice area, move the input slice to cover the panda and adjust the slice 
size as needed. 

 In the output slice area, adjust the output slice size as needed and move the slice to 
the desired screen. 

Set Slice Properties 

Output Slice 

The output slices are used for the construction of the output image. The output slice 
outputs the image of the corresponding input slice, and then scales the input slice 
image according to the output slice size you set. Select the desired output slice in the 
output slice area, and then set the slice properties on the right. 
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 Output slice properties 

 

Table 4-4 Function descriptions 

Area Parameter Description 

Basic properties Name Display or change the name of the output slice. 

Position View or set the output slice position in the Output 
| Slice area. The origin of the Output | Slice area is 
the adjustment reference point and the 
adjustment unit is the pixel. 

 X: View or set the horizontal coordinate of the 
top left corner of the output slice in the Output 
| Slice area.  

 Y: View or set the vertical coordinate of the top 
left corner of the output slice in the Output | 
Slice area. 

Size View or set the output slice size. 

 W: View or set the output slice size in the 
horizontal direction. 

 H: View or set the output slice size in the 
vertical direction. 

 Click  between W and H to lock the slice 
aspect ratio. 

Ratio Set the aspect ratio of the output slice. 

Rotation Rotate the output image clockwise based on the 
center of the output slice. 
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Area Parameter Description 

Flip Set the flipping mode of the output image. 

 Horizontal: Flip the output image in the 
horizontal direction.  

 Vertical: Flip the output image in the vertical 
direction. 

Priority View or set the displaying priority of the output 
slice. 

 Display: Indicate the priority of the output slice 
by a number. The larger the number, the 
higher the priority, i.e., the more front the 
output slice is displayed. 

 Adjustment: Select the desired output slice, 

and then click , ,  or  to 
adjust its priority. 

Color properties Opacity Adjust the transparent degree of the output slice. 
The value ranges from 0% (totally transparent) to 
100% (nontransparent). 

R/G/B Adjust the RGB values of the output slice. 

Advanced Anchor Enable or disable the anchor editing function. 

Lines After the editing function is enabled, set the color 
of the anchor lines. 

Stepping After the editing function is enabled and you use 
the keyboard arrow keys to move the anchor, this 
parameter is used to set the anchor moving 
distance each time you press the arrow key. 

Position After the editing function is enabled, enter the 
specific values of X and Y to precisely position the 
anchor. 

Layers 

Select the desired layer in the input slice area, and then set the layer properties on the 
right. 

 Layer properties 

 

 Name: Display or change the name of the layer. 

 Position: View or set the layer position in the input slice area. The origin of the 
input slice area is the adjustment reference point and the adjustment unit is the 
pixel. 
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− X: View or set the horizontal coordinate of the top left corner of the layer in the 
input slice area. 

− Y: View or set the vertical coordinate of the top left corner of the layer in the 
input slice area. 

 Size: View or set the layer size. 

− W: View or set the layer size in the horizontal direction. 

− H: View or set the layer size in the vertical direction. 

− Click  between W and H to lock the slice aspect ratio. If one of the two 
values is changed, the other value will change automatically according to the 
aspect ratio. 

Input Slices 

Select the desired input slice (highlighted when selected) in the input slice area, and 
then set the input slice properties on the right.  

The input slice is used to select a specific image area of the input source image. 

 Input slice properties 

 

Table 4-5 Function descriptions 

Parameter Description 

Basic properties 

Name Display or change the name of the input slice. 

Position View or set the input slice position upon the layer. The top left corner of 
the layer is the adjustment reference point and the adjustment unit is the 
pixel. 

 X: View or set the horizontal coordinate of the top left corner of the 
layer slice upon the layer.  

 Y: View or set the vertical coordinate of the top left corner of the layer 
slice upon the layer. 

Size View or set the input slice size. 

 W: View or set the input slice size in the horizontal direction. 

 H: View or set the input slice size in the vertical direction. 
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Parameter Description 

Ratio Set the aspect ratio of the input slice. 

Rotation Set the rotate degree of the input slice. The reference point is the center of 
the output slice. 

Advanced properties 

Anchor  Enable or disable the anchor editing function when the input slice is a 
polygon slice. 

Lines  After the editing function is enabled, set the color of the anchor lines. 

Stepping  After the editing function is enabled and you use the keyboard arrow keys 
to move the anchor, this parameter is used to set the anchor moving 
distance each time you press the arrow key. 

Position  After the editing function is enabled, enter the specific values of X and Y 
to precisely position the anchor. 

 Note  

The rectangle slices in the input slice area do not support advanced property settings  

Configure Link Backup 

Pilot MS3 supports the device backup to set the backup relationship between two 
devices. You can set one of the devices as the primary device or the backup device. 
When the primary device has got a problem or the primary device's cable fails, the 
backup device will take over the responsibilities of the primary device seamlessly, 
and continue to work well to ensure the LED screen will not go black. 
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 Application 

 

Prerequisites 

 The primary and backup devices must be on the same network segment. 

 The primary and backup devices must be connected to the same downstream 
device, such as an F4 shown above. 

Operating Procedure 

 On the primary device, go to Link > Link Settings or click Output > Link. 
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 Link settings 

 

In the device list, the system will automatically search for all the online devices on the 
current network segment. 

Device status descriptions: 

 Name: 

− The media server name 

− : The device is online. 

− : The device is offline. 

 IP: 

− The device IP address 

− : The device is not used as a backup one. 

− : The device is used as a backup one. 

 In the device list, select the device used as a backup one. 

 Select the desired device and drag it to the target primary device to complete the 
backup settings. 
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 Backup settings 

 

Other Operations 

On the output management page, right click the backup device to show the context 
menu. 

 Context menu for backup device 

 

 Click Disconnect to disconnect the backup device from the primary device. Right 
click again and select Connect to reconnect them. 

 Click Remove to delete the backup device and remove the backup relation 
between the primary and backup devices. 

Produce Programs 
The playback unit of Pilot MS3 is the program.  

After you have completed the construction of the outputs and added images to the 
layers, the system will output the image according to your construction (slices). 
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Edit Programs 

The system provides 50 programs by default. Before the playback of a program, you 
must add the media files or input sources to the layers of the programs. 

Select the desired media file or input source in Media Library and drag it to the target 
program layer in the Plan area. 

 Edit programs 

 

The functions of the icons in the Plan area are described as follows. 

 : Return to the first program column. 

 : Locate the program that is being played or edited. 

 : Add a new program. 

 : Turn off the image display of the selected layer. 

 : Turn on the image display of the selected layer. 

 : Turn off the audio of the selected layer. 

 : Turn on the audio of the selected layer. 

Set Media Continuation 

When you want to play media content in the same layer of multiple continuous 
programs, you may need to add the same media file to each program. The added 
media will be played from the beginning when a new program starts, which may not 
be what you want to see. The cross-program media continuation function can 
perfectly solve this problem. After you have enabled this function for a specified 
media, the program will be played continuously but not played from the beginning 
when a new program is started. 

 Right click the desired media in the Plan area and select Cross-P Media Continuation 
from the context menu. 
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 Set media continuation 

 

 Click and drag the media to the target program. 

 Note  

Right click the target program media after the cross-program continuation, and then select Cancel 
Continuation to delete the continuation settings.  

Set Program Properties 

Program Menu 

Right click a program to show the context menu as shown in the following, and you 
can set the program properties as needed. 

 Set program properties 
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 Play: Play the current program. 

 Pause: Pause the program playback. The program will be played from where it is 
paused next time when it is played. 

 Stop: Stop the program playback. The program will be played from the beginning 
next time when it is played.  

 Map to Preview: Show the program content in the preview area. 

 Enable Keep: When the playback switches to the program, it starts to play from 
the last position.  

 Disable Keep: When the playback switches to the program, it starts to play from 
the beginning. 

 Rename: Change the program name. 

 Cut: Cut the current program. 

 Copy: Copy the current program and its properties. 

 Paste: Paste the copied program and its properties to the specified program. 

 Insert Before: Add a new program before the current program column.  

 Insert After: Add a new program after the current program column.  

 Delete Program: Clear all the layer data in the program and delete the program. 

Program Properties 

 Select a layer in the Plan area or Editing Area. 

 Select the Properties tab on the right pane of the user interface to show the program 
property settings. 

 Program properties 

 

 Name: View or change the program name. 

 Status: Display the playback status of the current program. 

 Keep: After this is enabled, when the playback switches to the program, it starts to 
play from the last position. After this is disabled, when the playback switches to 
the program, it starts to play from the beginning. 

 Switching: Set the transition effect for program switching. The options include 
Fade and Cut. 

 Fade In: When Fade is selected, set the duration for the current media to appear. 
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 Fade Out: When Fade is selected, set the duration for the current media to 
disappear. 

 Brightness: Set the brightness of the images in the program. 

 Contrast: Set the contrast of the images in the program. 

 Add Before: Add a new program before the current program. 

 Add After: Add a new program after the current program. 

 Delete Program: Clear all the layer data in the program and delete the program. 

Media Context Menu in Program 

Right click a media in a program in the Plan area to show the context menu. 

 Media context menu 

 

 Play: Play the current media. 

 Pause: Pause the media playback. The media will be played from where it is 
paused next time when it is played. 

 Stop: Stop the media playback. The media will be played from the beginning next 
time when it is played.   

 Cross-P Media Continuation: When you want to play a media in the same layer of 
multiple continuous programs, you may need to add the same media file to each 
program. The added media will be played from the beginning when a new program 
starts, which may not be what you want to see. The cross-program media 
continuation function can perfectly solve this problem. After you have enabled this 
function for a specified media, the program will be played continuously but not 
played from the beginning when a new program is started. 

 Cancel Continuation: After the cross-program media continuation function is 
enabled, this item is available and you can cancel the cross-program continuation 
settings. 

 Rename: Change the name of the media in the program. The media name in the 
media library is changed at the same time. 
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 Jump: Set the jump playback mode of the current media after the media playback 
ends. 

− Loop: Loop the playback of the selected media in the program, and then  
will be displayed at the top right of the layer in the Plan area. 

− EOF: The current media will stop the playing and display the last frame after 

being played once, and  will be displayed at the top right of the layer in the 
Plan area. 

− Stop: The playback will stop after being played once, and  will be displayed 
at the top right of the layer in the Plan area. 

− Next Program: Jump to the next program after the current media playback 
ends. 

− Jump to Specified Program: Specify the desired program and the specified 
program will be played automatically after the current program is completed. 

 Enable Keep: When the playback switches to the media, it starts to play from the 
last position.  

 Disable Keep: When the playback switches to the media, it starts to play from the 
beginning. 

 Enable/Disable Subtitle: Turn on or turn off the subtitle display for the selected 
media. 

 Cut: Cut the media in the layer of the current program. 

 Copy: Copy the media in the layer of the current program. 

 Paste: Paste the copied or cut media. 

 Copy Properties: Copy the properties of the selected media. 

 Paste Properties: Paste the copied media properties to another media. 

 Locate Media: Locate the current media file in the media library. 

 Delete Media: Delete the selected media. 

Program Media Properties 

 Select the desired media in a program. 

 Select the Properties tab on the right pane of the user interface to show the media 
property settings. 
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 Media properties 

 

Table 4-6 Media property descriptions 

Area Function Description 

Name View or change the media name. 

Time Duration View the length of the media playing time. 

Start Time 
Set the start time of the media playback. The start time 
value cannot be later than the media duration. 

End Time 
Set the end time of the media playback. The end time 
value is later than the start time, and cannot be later 
than the media duration. 

Delay Set the delay time of the media playback, that is, the 

duration the program is played before the media starts 
playing. 
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Play Play Set the playback mode of the current media during the 
playing time of the program. 

 Loop: Loop the playback of the selected media in 

the program, and then  will be displayed at the 
top right of the layer in the Plan area. 

 EOF: The current media will stop the playing and 
display the last frame after being played once, and 

 will be displayed at the top right of the layer in 
the Plan area. 

 Stop: The playback will stop after being played 

once, and  will be displayed at the top right of 
the layer in the Plan area. 

 Loop Times: Set the loop playback times of the 

current media, and  is displayed at the top right 
of the layer in the Plan area. ("N" stands for the 
number of loop times). 

Jump Set the jump playback mode of the current media after 
the media playback ends. 

 No Jump: No operation will be performed after the 
current media playback ends. 

 Next Program: Jump to the next program after the 

current media playback ends, and  will be 
displayed at the top right of the layer in the Plan 
area. 

 If you have enabled the program jump, the group 
name and program name of the next program are 

displayed and  will be displayed at the top right 
of the layer in the Plan area. 

Switching Set the transition effect for switching the current media 
in the program layer. The options include Fade and Cut. 

Fade In When Fade is selected, set the duration for the current 
media to appear. 

Fade Out When Fade is selected, set the duration for the current 
media to disappear. 

Keep After this is enabled, when the playback switches to the 
program, it starts to play from the last position. After 
this is disabled, when the playback switches to the 
program, it starts to paly from the beginning. 

Subtitle Turn on or turn off the subtitle display. 

Speed Set fast playback speed for the media. 

Volume Adjust the output volume of the media. 

Click  on the right of the volume to turn off the 
output volume of the layer. 
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Image Filling Set how the image is displayed in the selected layer. 

 Fill: The image fills the layer. 

 Proportional: The image is scaled and displayed in 
the layer according to its original aspect ratio. 

Flip Set the display mode of the output image. If H and V are 
not selected, the output image is displayed normally, 
without any flipping effect. 

 H: Flip the image horizontally. 

 V: Flip the image vertically. 

Brightness Set the overall brightness of the layer image. The value 
range is 0%–100%, and it defaults to 50%. 

Contrast Set the overall contrast of the layer image. The value 
range is 0%–100%, and it defaults to 50%. 

Opacity Set the transparency of the output image. The value 
range is 0% (totally transparent)–100% (opaque), and it 
defaults to 100%. 

Saturation Adjust the colorfulness of the output image. The value 
range is 0%–100%, and it defaults to 50%. 

Hue Set the relative degree of how bright or dark the output 
image is. The value range is 0%–100%, and it defaults 
to 50%. 

Y/C Stretch After enabled, the output image is brighter in the bright 
areas and darker in the dark areas.  

This function is disabled by default. 

Crop Crop  Cropping method: 

− Stretch: Stretch or shrink the output image. 

− Crop: Crop the output image. 

− Proportional: Scale down the output image. 

 Proportional: 

− Enabled: The unit for the cropping is the 
percentage. 

− Disabled: The unit for the cropping is the pixel. 

T: Set the size of the shrunk/cropped/scaled down 
area at the top part of the media. 

B: Set the size of the shrunk/cropped/scaled down 
area at the bottom part of the media. 

L: Set the size of the shrunk/cropped/scaled down 
area at the left part of the media. 

R: Set the size of the shrunk/cropped/scaled down 
area at the right part of the media. 



Pilot MS3 Professional Multimedia Playback Software 
User Manual 4 Project 

 

www.pixelhue.com 52 
 

Keying Remove a specific color from the selected media. 

Check the box next to Enable to enable the function. 

 Select the desired keying method to set the color 
to be keyed. 

Four keying methods are supported: 

− Click the eyedropper  and select the color 
to be removed on the screen. 

− Click the color block and select the color in 
the displayed Select Color window. 

− Next to #, enter the value of the color to be 
removed. 

− Double click the values next to RGB and enter 
their values, respectively, to precisely set the 
color. 

 Strength: The higher the value, the wider the 
keying color range and the stronger the color 
correction.  

When precise keying is required for a specific 
image, it is recommended to set the value smaller 
than 10%; for other cases, it is recommended to 
set it greater than 50%. 

 Shadow: The higher the value, the cleaner the noise 
area that contains shadows in the foreground. 

Borders Configure the size and color of the image borders. 

Check the box next to Borders to enable the 
function. 

 Set the border color. Four methods are available: 

− Click the eyedropper  and select the 
desired color on the screen. 

− Click the color block and select the color in 
the displayed Select Color page. 

− Next to #, enter the value of the desired color. 

− Double click the values next to RGB and enter 
their values, respectively, to precisely set the 
color. 

− Click the A value and enter a value to set the 
border opacity. The value range is 0% (totally 
transparent)–100% (opaque). 

 Set the border size. Two methods are available.  

− Percent: Set the percentage of the border size 
to the media. 

− Pixels: Set how many pixels the border 
occupies. 
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Set Program Jump 

After the program editing is completed, set the program jump to realize the 
automatic continuous playback of the programs. 

Before the program jump settings, you need to specify a media in each program as 
the timing base. After the playback of the selected media ends, the specified 
program will start to play. 

 Select the desired media in a program in the Plan area and right click the media to 
open the context menu. 

 Go to Jump > Jump to Specified Program and all the programs become selectable. 

 Program jump 

 

 Select the desired program to complete the jump settings. 

If you want to jump to a program in another group, click the name of the group where 
the program belongs, and then click the program name to complete the program 
jump between program groups. 

 Repeat Step 1 to Step 3 to complete the jump settings for more programs. 

After the program jump settings,  is displayed at the top right of the layer in the 
Plan area. 

 Note 

When two programs become jump partners for each other, they will be played circularly.  

Manage Program Groups 

When you need a large number of programs, you can create groups to manage those 
programs. Each group supports 20 programs by default. 

 Click + at the bottom left in the Plan area to add a program group. 
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 Add program groups 

 

 Right click the group name and select Rename to give the group a new name. 

 Rename groups 

 

 Click + at the top right to add new programs to the newly-added group. 

Playback Control 
After the program editing, you can play the programs. 

 Control the program playback. 

− Click  next to a program name in the Plan area to play the program. 

− Click  to pause the program playback. 

(The  icon turns to  during the program playback. The  icon turns to 

 after the program is paused.) 

− Click  to continue the program playback. 

 Switch the playback content. 

During the playback of a program, switch the playback content of a layer. For 
example, in the below figure, when Program 1 is being played, double click the 
media in Layer 2 of P 2 to switch the playback of the media.  
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 Playback control-1 

 

 Control the media playback. 

In the playback control area, control the playback of a single media or all the 
media. 

 Playback control-2 

 

− Click  or  on the left side to play or pause the playback of all media in a 

program; click  on the left side to stop the playback of all media in a 
program. 

− Click  or  next to a media name to play or pause the playback of the 
selected media. 

− Click  at the top right, and the program media adopts the count up timer. 

− Click  at the top right, and the program media adopts the countdown timer. 

− Click  at the top right, click the name of the program to be played 
synchronously and drag the media playback progress bar to play two media 
synchronously. 

− Click  at the top left to set the fast-forward and rewind speed. The 
options include 2s, 4s, 8s and 16s. (The number refers to the playback speed 
and the unit is second.) 

− Click  to set the fast-forward speed. 

− Click  to set the rewind speed. 

 In the Preview area, click Cut or Take to send the preview program to the screen. 
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 Preview playback 

 

− Cut: Send the currently previewed program to the screen without transition 
effect. 

− Take: Send the currently previewed program to the screen with the fade 
transition effect. 

− If Keep is selected and the program is sent to the screen via Take or Cut, the 
program will be played from the current playback progress in the preview area. 
If Keep is not selected and the program is sent to the screen via Take or Cut, 
the program will be played from the beginning. 

 FTB: 

Click  at the upper left of the main interface and the output image will fade to 
black within the time you set. 

The time ranges from 0 to 5s and it defaults to 1s. 

Save Projects 

You can save the editing and settings as an independent project file for easy use in 
the future. 

 Go to File > Save or Save As to save the current project file (*.pms3) to your local 
storage. 

 Click  at the top left of the main interface to create a new project. 

 Click  at the top left of the main interface to save the current project. 

 Click  at the top left of the main interface to save the current project as a new 
project file. 

 Click  at the top left of the main interface to package the current project, such 
as all the used media or all the media files and project files, which is convenient 
for future use. 
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5 Settings  

About This Chapter 

This chapter introduces you to various settings of the software. 

Overview 

 System Settings 

 Authorization 

 Hotkey Binding 

 MIDI Binding 
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System Settings 

Set the startup-related settings. Go to Settings > System Settings to open the 
System Settings window. 

General 

 System settings 

 

Basic 

 Start software after power on 

− Selected: Automatically launch Pilot MS3 when the system is started. 

− Deselected: Do not automatically launch Pilot MS3 when the system is started. 

 Start software and open recent project after power on 

− Selected: Automatically open the last edited project when Pilot MS3 is 
launched. 

− Deselected: Display the default interface when Pilot MS3 is launched. 

 Play project after opened 

− Selected: When you open a project, the project will be played from where it 
stopped playing last time. 

− Deselected: When you open a project, no media will be played and the project 
interface will be displayed. 

 Auto save project 

Set an interval that the system will automatically save the project. The value 
ranges from 1 to 30 min and it defaults to 5 min. 

Canvas 

Set the background color of the editing area. 
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In the canvas settings area, change the background color of the editing area by 
selecting a preset color or customizing a color. 

After the basic and canvas settings are done, click OK to apply the settings. 

Display 

 Display settings 

 

Coding and Decoding 

 Main Program Window: Select the graphics card for the rendering of the program 
main user interface. After the configuration, you need to restart the software. 

 HDR: Enable the HDR rendering output. 

 SDR: Enable the SDR rending output. 

General 

 Fade In: Set the time length from when the current media starts to play to when 
the media is fully displayed. The value ranges from 0 to 10 s. When the value is 
set to 0 s, there is no transition effect. 

 Fade Out: Set the time length from when the current media starts to stop to when 
the media is stopped. The value ranges from 0 to 10 s. When the value is set to 0 
s, there is no transition effect. 

 Apply to All: Apply the duration of Fade In and Fade Out to all the programs. After 
the time length is set, if you do not click Apply to All, the transition will only be 
effective on the programs without the added media. 

 MFPS: Real-time frame rate 

− Selected: Display the real-time frame rate at the bottom right on the media 
preview window. 

− Deselected: Do not display the real-time frame rate on the media preview 
window. 

After the coding and decoding and general settings are done, click OK to apply the 
settings. 
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Synchronization 

Configure the synchronization mode for graphics cards. When multiple graphics 
cards are deployed in a mosaic setup, enabling the synchronization between the 
graphics cards is necessary to ensure the consistent display across the graphics 
card connectors. Check the Sync between graphic cards box to activate 
synchronization function. 

After completing the configuration, please restart the software for the system 
settings to take effect. 

Audio 

On the system settings window, click Audio to enter the audio settings tab page. 

 Audio settings 

 

Select an audio output channel from the drop-down list next to Channel. Click OK to 
complete the audio settings. 

Office 

Pilot MS3 supports playback of PowerPoint files. Before playback, configure the 
basic information of PowerPoint files. 

On the system settings window, Click Office to enter the office settings tab page. 
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 Office settings 

 

 Resolution: Set the resolution according to the resolution of the PowerPoint file. 

 Slide Transition: Set the transition of each slide of the PowerPoint document 
during playback. 

− Animation Mode: Show the animations of slides during playback. 

− Picture Mode: Do not show the animations of slides. 

 Use arrow keys to switch between slides 

− Selected: Allow arrow keys to be used to switch between slides. 

− Deselected: Arrow keys cannot be used to switch between slides. 

Click OK to complete the office settings. 

Authorization 

One authorization dongle corresponds to only one authorization file. When the dongle 
matches the authorization file, Pilot MS3 can be used normally. 

Pilot MS3 supports the centralized management of multiple authorization files. When 
an authorization dongle is inserted, the system can automatically identify the 
corresponding authorization file to ensure the normal operation of Pilot MS3. 

 Import the authorization file. 

1. Go to Settings > Authorization to open the authorization settings window. 

2. Click Import at the bottom to open the authorization file importing window. 

3. Select the desired authorization file and click Open. The system will automatically 
import the file to Pilot MS3. 
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 Authorization file 

 

 Check the authorization. 

1. Insert the authorization dongle into the system. 

2. The system will automatically identify the authorization file according to inserted 
the authorization dongle, and then display In Use after successful identification. 

Hotkey Binding 

Pilot MS3 supports custom hotkeys, and users can use those keys to operate Pilot 
MS3 simply and conveniently. Go to Settings > Hotkey Binding to show the hotkey 
settings interface, and the areas where you can carry out the hotkey binding are 
highlighted. 

 Hotkey binding 

 

Click the target area, and then press the letter or number keys on the keyboard as 
needed to complete adding the hotkey. 

After the settings, go to Settings > Complete Binding to make the hotkeys take effect 
and exit the hotkey binding interface. 
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 Note  

The Ctrl+H key combination is a built-in global hotkey which can quickly locate the mouse to the 
center of the main interface. When you set the hotkeys, this combination cannot be used.  

For example: 

Set the hotkey for Program 1 to Q. 

a. On the hotkey settings interface, click Program 1. 

b. Press the letter Q on the keyboard, and then a letter Q will be displayed on 
Program 1. 

 

MIDI Binding 

Bind the Pilot MS3 functions with the MIDI (Musical Instrument Digital Interface) 
keyboard. After a successful binding, you can control Pilot MS3 by using a MIDI 
keyboard. 

Connect MIDI Keyboard 

Prerequisites 

 You have connected a MIDI keyboard to the computer where Pilot MS3 is 
installed. 

 Make sure the computer where Pilot MS3 is installed have successfully 
recognized the connected MIDI keyboard. 

Procedure 

 Click MIDI at the top right of the user interface to open the MIDI connection settings 
window. 
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 MIDI connection 

 

 Pilot MS3 will automatically recognize all the connected MIDI keyboards. 

 Select the desired MIDI keyboard from the MIDI List. 

 Click Connect to complete the connection. 

Bind MIDI 

 Go to Settings > MIDI Binding to show the MIDI binding page. You can see all the 
available functions that can be bound with a MIDI keyboard are highlighted. 

 Available functions for MIDI binding 

 

 Select the target function in Pilot MS3 and then press the desired key on the MIDI 
keyboard to complete the binding. 

After a successful binding, go to Settings > Complete MIDI Binding to make the 
binding take effect and exit the binding page. 
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6 Help  

About This Chapter 

This chapter introduces you the software-related and company-related information 
that may help you during the use. 

Overview 

 User Manual 

 Software Updates 

 About 
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User Manual 

Go to Help > User Manual on the menu bar to open and view the product user 
manual. 

Software Updates 

Check the current version of the software. When a new software version is detected, 
the system will download the latest version and then you can follow the instructions 
to complete the update. 

About 

View the software version, license agreement and other company-related 
information.
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7 Tools 

About This Chapter 

To better meet onsite playback requirements, Pilot MS3 has integrated some tools 
that can be used to edit video files. 

Overview 

 Transcoding Assistant
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Transcoding Assistant 

Pilot MS3 supports the conversion of the video coding format, code rate, resolution, 
and frame rate to satisfy the requirements of different playback scenarios. 

 Go to Tools > Media Transcoding to open the transcoding assistant window. 

 Transcoding assistant 

 

 Click Add at the bottom to open the local folder where you can select the desired file. 

You can also add multiple files by pressing the Ctrl key and selecting the files 
simultaneously. 

 Click Add to add them into the assistant. 

 Select the target video file. 

 On the right side, set the parameters of Coding, Quality, Code Rate, Frame Rate, 
Resolution and Audio. 

 Coding: Set the coding format of the transcoded video. The supported options 
include Adaptive, h264, h265, VP9 and hap. When Self-Adaptive is selected, the 
video will be transcoded according to the original video coding. 

 Quality: Set the quality of the transcoded video. The supported options include 
Low, Medium and High. 

− High: Keep the quality of the transcoded video the same as the original video 
quality. 

− Low: The quality of the transcoded video is relatively blurred compared to the 
original video quality. 

− Medium: The quality of the transcoded video is between the high and low 
qualities. 

 Code Rate: Set the code rate of the transcoded video. The supported options 
include Self-Adaptive and Custom. 
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− Adaptive: The code rates before and after the transcoding are the same. 

− Custom: Set the desired code rate and the video will be transcoded according 
to the set value. 

 Frame Rate: Set the frame rate of the transcoded video. The supported options 
include Self-Adaptive, 24, 30, 60 and Custom. 

− Adaptive: The frame rates before and after the transcoding are the same. 

− 24/30/60: The frame rate after the transcoding will be 24 Hz, 30 Hz, and 60 Hz, 
respectively. 

− Custom: Set the desired frame rate and the video will be transcoded according 
to the set value. 

 Resolution: Set the resolution of the transcoded video. 

− W: Set the horizontal size of the transcoded video. The value defaults to 1920 
and the recommended maximum value is 8192 

− H: Set the vertical size of the transcoded video. The value defaults to 1080 and 
the recommended maximum value is 8192.  

− If the set resolution after the transcoding is greater than the resolution of the 
original one, the resolution of the transcoded one will be the original resolution. 

 Audio: Set how to deal with the audio that comes with the video. The supported 
options include Keep and Remove. 

− Keep: The transcoded video retains the audio in the video before transcoding. 

− Remove: The transcoded video display pure images without any audio. 

 Click Transcode and the system will automatically start the transcoding process. 

When the progress reaches 100% in the Progress column, the transcoding 
completes. After the transcoding, the video will be saved in the path specified in Save 
Path. 

 Click Open to open the local folder where you can view the transcoded files. 

 Click Change to change the save path. 

 Click Delete at the bottom to delete the selected video files.
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8 Graphic Card Mosaic 

About This Chapter 

This chapter helps you to configure the graphics card mosaic function. 

Overview 

 Set Main Display 

 Change Resolutions 

 EDID Management 

 Output Mosaic 
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Set Main Display 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 

 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at the bottom left 
corner on each display.  

 For the Multiple displays item, select Extend these displays. 
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 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Check the box next to Make this my main display. 

Change Resolutions 

Set Standard Resolutions 

 Right click on your desktop and select Display settings. 

 Display settings 

 

 Select a display to set it as the main display. 
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 Multiple displays-1 

 

 Note 

When multiple displays are connected, you can click Identify to show the number at the bottom left 
corner on each display.  

 For the Display resolution item, select the desired output resolution. 

 Multiple displays-2 

 

 On the window that appears, select Keep changes. 

 Confirmation 

 

 Repeat Step 2 to Step 4 to complete the resolution settings for other displays. 

Set Custom Resolutions 

 Right click on your desktop and select NVIDIA Control Panel. 
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 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Display > Change resolution. 

 Change resolutions 

 

 Select the desired display. 

 Click Customize to show the customize window. 

 Custom resolution-1 

 

 Click Create Custom Resolution. 

 Read the disclaimer information carefully and click Accept to show the Create 
Custom Resolution window. 
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 Select the desired display. 

 Custom resolution-2 

 

 Set the horizontal pixels, vertical lines, refresh rate and scan type. 

 Click Test and then click Yes on the window that appears. 

 Confirmation 
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 Custom resolution-3 

 

 Click OK to complete the custom resolution settings. 

After a custom resolution is created successfully, it will appear in the custom area as 
shown in the figure below. 

 Custom resolution-4 

 

EDID Management 

After the display resolution settings, you need to manage the EDID for precise 
identification of display properties and to avoid the on-site screen display disorder. 

Load EDID  

The procedure of how to load the EDID is as follows. 

 Right click on your desktop and select NVIDIA Control Panel. 
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 NVIDIA control panel 

 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 NVIDIA control panel 

 

 Click EDID (Monitor) next to a desired output connector of the current graphics card 
to show the EDID management window. 

 EDID (Monitor) 
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 Manage EDID  

 

 Click Export EDID and then name the exported EDID file in the window that appears. 

 Select the Load tab to show the EDID loading window. 

 Click Browse and then select the EDID file exported in Step 4. 

 In the Select Connector to force EDID area, select the desired connector. 

 Load EDID 

 

 Click Load EDID. 

 On the dialog box that appears, click OK to complete loading the EDID. 

 EDID loaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the 
original EDID (Monitor) changes to EDID (File), the EDID is loaded successfully.  
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 EDID loaded successfully 

 

Unload EDID  

The procedure of how to unload the EDID is as follows. 

 On the NVIDIA Control Panel interface, go to Workstation > View system topology. 

 Click EDID (File) to show the EDID management window. 

 EDID (File) 

 

 Select the Unload tab and then select the desired connectors. 
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 Unload EDID 

 

 Click Unload EDID. 

 After the EDID is unloaded successfully, click OK on the dialog box that appears. 

 EDID unloaded successfully 

 

 Go back to Workstation > View system topology to check the EDID status. If the EDID 
(File) changes to EDID (Monitor), the EDID is unloaded successfully.  

Output Mosaic 

The graphics card supports connector mosaic output. The output connector mosaic 
must observe the following rules. 

 The graphics card does not support irregular mosaic layouts. The mosaic layout 
must be 1×2, 1×3, 1×4, 2×2, 2×1, 3×1 or 4×1. 

 The output resolutions of the graphics card connectors that are used for mosaic 
must be the same. 

 Right click on your desktop and select NVIDIA Control Panel. 

 NVIDIA control panel 
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 On the NVIDIA Control Panel interface, go to Workstation > Set up Mosaic. 

 Set up mosaic 

 

 Click Create new configuration to show the mosaic settings window. 

 Mosaic settings 

 

 Select the screen number from the drop-down list of Number of displays. 

 Select the screen mosaic layout from the drop-down list of Topology (rows x 
columns). 

 Select the screen orientation from the drop-down list of Orientation of displays. 

 Click Next to proceed. 
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 Select displays 

 

 Select the connected displays and then select their refresh rate and resolution. 

 Click Next to proceed. 

 Arrange displays 

 

 Arrange the displays according to the screen arrangement and structure by dragging 
the available displays to the corresponding topology areas. 
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 Arrange displays 

 

 Click Apply and then click Yes on the confirmation window. 

 Click Next to proceed. 

 Adjust overlap and bezel correction 

 

You can perform overlapping adjustment or bezel correction to the vertical or 
horizontal edges of the display as needed.  

1. Select whether to use the same settings for all the vertical or horizontal edges of 
the display in the Select how overlap/bezel correction is applied area. 

2. Select the desired edges and then enter the overlap or bezel correction values for 
the selected edges. Click Apply after the settings are done. 

 Click Finish to complete the mosaic settings. 
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 Mosaic completed 
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9 External Control 

About This Chapter 

This chapter guides you how to control and use Pilot MS3 on an event controller or 
other third-party devices. 

Overview 

 Control via Event Controller 

 Control via Stream Deck 
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Control via Event Controller 

If you are using Pilot MS3 (X400 media server) for your event, you can easily control 
it on the U3 and U5 series (U5 and U5 Pro) event controllers from PIXELHUE. This can 
be achieved through the joint control method and the KVM control method, providing 
convenient on-site device control. 

In the joint control scenario, the Pilot MS3 programs can be read and displayed on 
the event controller. You can then bind these programs to the event controller’s 
preset buttons, allowing you to effortlessly switch and play them. 

In the KVM control scenario, the Pilot MS3 user interface can be displayed on the 
event controller, enabling you to perform all Pilot MS3 operations using the event 
controller's mouse and keyboard, especially switching and playing programs. 

Furthermore, the above two control methods can be seamlessly combined, offering 
enhanced flexibility in managing the Pilot MS3 for your event. 

Joint Control 

U3 Event Controller 

 Complete the physical connections. 

1. Connect the U3 and X400 to the same local area network by either directly 
connecting them with an Ethernet cable or connecting them through a router. 

2. Connect the X400’s CONTROL UI connector to a monitor using an HDMI cable. 

3. Connect the X400’s Type-A ports to a keyboard and a mouse using USB cables. 

 Physical connections between the U3 and X400 
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 In Pilot MS3 on the monitor, click Event Controller in the upper right corner, as shown 
in Figure 9-2, to enable the X400 to be discovered by the U3 and displayed in the 
device list on the right side of the U3 primary screen, as shown in Figure 9-3. 

 Enabling the X400 to be discovered by the U3  

 

 Go to Settings > Peripheral on the event controller to enter the peripheral 
management page. 

 Peripheral management 

 

 From the device list of the U3 primary screen, select your online media server. 

 Green: The media server is online.  

 Gray: The media server is offline. 

Operations: 

 Refresh: All the peripheral devices are automatically identified and listed here. You 
can also tap Refresh to manually refresh the device list. 

 Delete: Select the target device and tap Delete. 

 On the U3 primary screen, select a program and drag it to the target preset button to 
bind the program to the desired preset button. 
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Binding rules are as follows: 

 One program can be bound to different buttons. 

 One button can be bound to only one program of a device. 

 One button can be bound to programs from different devices. 

Operations: 

 Sync: After a different device is selected or a program changes, the program list 
will be synchronized automatically to the event controller. You can also tap Sync 
to manually synchronize the programs. 

 Nonempty Programs: Select this option to view the programs that have the 
content. 

Preset button status LEDs: 

 Yellow: Only the switcher preset is bound to the button. 

 Blue: Only the media server program is bound to the button. 

 Purple: Both program and preset are bound to the button. 

 Green: The preset is selected. 

 Off: The preset is not used. 

 Perform other necessary operations as required. 

 Unbind a single button: Tap and drag NULL at the top to the target button. 

 Unbind all buttons: Tap Unbind All. 

 Press the preset button on the front panel to switch the program. 

 Press the CUT or TAKE button, or push the T-bar to play the programs. 

U5 and U5 Pro Event Controllers 

The control operations and settings on the U5 and U5 Pro are basically the same. 
Here we take the U5 Pro to illustrate. 

 Complete the physical connections. 

1. Connect the U5 Pro and X400 to the same local area network by either directly 
connecting them with an Ethernet cable or connecting them through a router. 

2. Connect the X400’s CONTROL UI connector to a monitor using an HDMI cable. 

3. Connect the X400’s Type-A ports to a keyboard and a mouse using USB cables. 
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 Physical connections between the U5 Pro and X400 

 

 In Pilot MS3 on the monitor, click Event Controller in the upper right corner, as shown 
in Figure 9-5, to enable the X400 to be discovered by the U5 Pro and displayed in the 
device list of the U5 Pro screen, as shown in Figure 9-6. 

 Enabling the X400 to be discovered by the U5 Pro 
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 On the U5 Pro, select the target switcher, double tap it to enter the device operation 
page, and then tap Peripheral Management. 

 Peripheral management 

 

 From the device list of the U5 Pro screen, select your online media server. 

 Green: The media server is online.  

 Gray: The media server is offline. 

Operations: 

 : All the peripheral devices are automatically identified and listed here. You can 
also tap this icon to manually refresh the device list. 

 : Select the target device and tap this icon to delete the selected device. 

 On the U5 Pro screen, tap to select a program and on the displayed virtual preset 
button page, tap the target preset button to bind the program to the desired preset 
button. 

 Binding program to preset button 
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Binding rules are as follows: 

 One program can be bound to different buttons. 

 One button can be bound to only one program of a device. 

Operations: 

 Sync: After a different device is selected or a program changes, the program list 
will be synchronized automatically to the event controller.  

 Nonempty Program: Select this option to view the programs that have the content. 

Preset button status LEDs: 

 Yellow: Only the switcher preset is bound to the button. 

 Blue: Only the media server program is bound to the button. 

 Purple: Both program and preset are bound to the button. 

 Green: The preset is selected. 

 Off: The preset is not used. 

 Perform other necessary operations as required. 

 Unbind a single button: Tap NULL and on the displayed virtual preset button page, 
tap the target preset button. 

 Unbind all buttons: Tap Unbind. 

 Press the preset button on the front panel to switch the program. 

 Do the following to play the programs. 

 If the connected switcher is in PGM only mode, the selected program will be 
played directly after you press the preset button. 

 If the connected switcher is in switcher mode, press the CUT or TAKE button, or 
push the T-bar to play the programs. 

KVM Control 

U3 Event Controller 

 Complete the physical connections. 

1. Connect the U3’s DVI INPUT connector to the X400’s CONTROL UI connector 
using a DVI to HDMI cable. 

2. Connect the U3’s Type-B port to the X400’s Type-A port using a USB cable. 

3. Connect a mouse and keyboard to the U3’s USB ports on the right side. 
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 Physical connections between the U3 and X400 

 

 Press the MVR button in the FUNCTION area on the U3 front panel, and the MVR 
button indicator turns green, indicating the U3 secondary screen is dedicated to the 
media server and displays the Pilot MS3 user interface. 

 On the U3, go to Settings > Event Controller to enter the virtual controller page. 

 On the secondary screen, complete the external screen settings. 

 Secondary screen – external screen settings 

 

 Screen Quantity: Set the quantity of the screens loaded by the media server. The 
screen quantity equals the quantity of available output connectors on the output 
cards of the media server plus one.  
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To confirm the screen quantity, click on the Pilot MS3 desktop to open Display 
settings and you will directly see the screen quantity. After the screen quantity is 
set, the screens will be displayed graphically under Screen Quantity. 

 Width & Height: Set the resolution of each screen. 

 Set as U3 Operation Screen: Set which of the screens is the one that displays the 
Pilot MS3 user interface. 

 Once you are done, use the mouse and keyboard of the event controller to operate 
the Pilot MS3 user interface. Any operations in Pilot MS3 can be easily done with the 
mouse and keyboard, such as program switching and playback. 

 When you move the cursor to the secondary screen, all your mouse and keyboard 
operations apply to Pilot MS3. 

 When you move the cursor to the primary screen, all your mouse and keyboard 
operations apply to the event controller. 

U5 and U5 Pro Event Controllers 

The control operations and settings on the U5 and U5 Pro are basically the same. 
Here we take the U5 Pro to illustrate.  

 Complete the physical connections. 

1. Connect the U5 Pro’s MVR1, MVR2 or HDMI IN connector to the X400’s CONTROL 
UI connector using an HDMI cable. 

2. Connect the U5 Pro’s MIDI/KVM port to the X400’s USB port using a USB cable. 

3. Connect a mouse to the U5 Pro’s USB port on the right side. For the U5, you need 
to connect a mouse and keyboard to the U5’s USB ports on the right side because 
the U5 Pro has a built-in keyboard in the middle drawer on the front panel. 

 Physical connections between the U5 Pro and X400 
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 Press the MVR button on the U5 Pro front panel, and the MVR button indicator turns 
green. The ultrawide primary screen is divided into two screens. The secondary 
screen on the right half is dedicated to the Pilot MS3 user interface.  

For the U5, the primary screen will be dedicated to the Pilot MS3 user interface. 

 On the U5 Pro, select the target switcher, double tap it to enter the device operation 
page, and then tap KVM Settings. 

 On the displayed page, complete the KVM settings. 

 KVM settings 

 

 Mouse Roaming: Toggle this switch to enable or disable the mouse roaming 
function. When enabled ( ), your mouse can roam across the event controller’s 
primary screen and the Pilot MS3 screen. You can also press the MEDIA button on 
the event controller front panel to enable or disable this function. 

 Input Source: Select the input connector on the event controller that the HDMI 
cable is connected to: MVR1, MVR2, or HDMI IN. This is to tell the event controller 
which input connector is used to display the Pilot MS3 user interface. Only when 
the correct input connector is selected, all your mouse and keyboard operations 
can successfully apply to Pilot MS3. 

 Add Screens: Set the quantity of the screens loaded by the media server. The 
screen quantity equals the quantity of available output connectors on the output 
cards on the media server plus one.  

To confirm the screen quantity, click on the Pilot MS3 desktop to open Display 
settings and you will directly see the screen quantity. After the screen quantity is 
set, the screens will be displayed graphically under Add Screens. 

 Width and Height: Set the resolution of each screen. 

 Main Screen: Set which of the added screens is the main screen that displays the 
Pilot MS3 user interface. 

 : You can tap this icon to add a new KVM preset. 
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 / : Each KVM preset area has a radio button in the upper right corner. You 
can tap this button to select and enable the KVM preset. 

 Edit: If you want to manage the added KVM presets, tap Edit first. Then, you can 
change the KVM preset name, modify the KVM settings, or delete the KVM 
presets. 

 Once you are done, use the mouse and keyboard of the event controller to operate 
the Pilot MS3 user interface. Any operations in Pilot MS3 can be easily done with the 
mouse and keyboard, such as program switching and playback.  

 When you move the cursor to the secondary screen, all your mouse and keyboard 
operations apply to Pilot MS3. 

 When you move the cursor to the primary screen, all your mouse and keyboard 
operations apply to the event controller. 

Control via Stream Deck 

Pilot MS3 supports control through a third-party device (Stream Deck). When 
controlling through Stream Deck, it is necessary to complete the configuration of 
Stream Deck device through the Companion software. 

Software Obtaining and Preparations 

 User registration has been completed in companion official website 
(https://bitfocus.io/companion). 

 The supported Companion software version has been obtained from Pilot MS3 
technical support. 

 The computer with Companion installed is on the same network segment as the 
device with Pilot MS3. 

 The connection between Stream Deck and the device with Pilot MS3 has been 
completed. 

Software Configuration 

 After downloading the Companion installation package, double click the package to 
install the software. 

 After the installation, double click the Companion software shortcut to open the 
software. 
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 Companion software interface 

 

 Click Launch GUI to enter the Companion configuration page. 

 Companion configuration page 

 

 Enter the desired device or software name in the Add connection area search box on 
the Connections interface, and the system will automatically display all relevant 
product models or software names. 

 Search software 

 

 Click Add before the device model or software name you want to control. 
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 After adding the device or software, the system enters the Edit Connection 
configuration interface. 

 Connection configuration 

 

 Configure the control device or program. 

 Label: The name of the control device is required. The name can only contain 
letters, numbers, underscores and dashes. 

 IP Address: Enter the IP Address of the device to be controlled. If you control the 
software, you need to enter the IP Address of the device where the software is 
located. 

 UDP Port: Companion communicates with the controlled device through UDP. Fill 
in the UDP port number here, which defaults to 18960. If there is any change, 
please fill in the changed UDP port number. 

 Model: Select the controlled device or program. When there are multiple 
controllable programs on the device with the configured IP address, you need to 
select the controlled program name here. 

 Click Save to complete the connection configuration. 

If the configuration is correct, under the Connections tab, the status of the connected 

device is displayed as . 

 Device connection complete 

 

 Click Buttons to enter the Stream Deck button configuration interface. 
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 Stream Deck button configuration 

 

 In the Presets area on the right, click the added control device or program to expand 
the preset function menu. 

 Preset function menu 

 

 Expand the preset list on the right side, drag the preset buttons on the right side to 
the buttons of Stream Deck on the left side, and complete the button binding 
between the control function and Stream Deck.  
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 Function binding 

 

 Note  

Since Stream Deck does not support page navigation horizontally, when adding functions to the 
buttons on the Stream Deck, make sure the number of buttons horizontally matches the physical 
device.  

 Click Back to select different function menu and complete more function bindings. 

 More function binding 

 

 After the configuration is completed, the function name will be displayed on the 
button of Stream Deck. Press the corresponding button, and check whether the 
function bound to the button is triggered in the control program. 

 Yes = > Stream Deck is successfully configured.  

 No = > Contact your technical support to find out the reason and reconfigure. 

Other operations 

 Replace button function 

Directly drag a new function from the right side list to the target button to replace 
the existing function.  

 Delete button function 
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Click Delete at the bottom to activate button function deletion. Click the function 
on the button that needs to be deleted to delete the corresponding function. 

 Clear button functions 

Select the button page that needs to be cleared, click Wipe page at the bottom to 
clear all the added buttons functions on that page. 

 Note  

For more information, please refer to the Companion user manual.  

 


	Contents
	1  General
	1.1  About This Manual
	1.2  Symbols and Pictures

	2  Software Installation
	2.1  Software Installation
	2.2  Software Licensing

	3  User Interface Introduction
	3.1  Introduction
	3.2  Change UI Layout
	3.3  Load Layout
	3.4  Lock User Interface

	4  Project
	4.1  Create New Projects
	4.2  Manage Media
	4.2.1  Add Media
	4.2.1.1  Import Files
	4.2.1.2  Import Folders

	4.2.2  Edit Media
	4.2.2.1  Media Optimization
	4.2.2.2  Create Playback Collection
	4.2.2.3  Media File Group Management
	4.2.2.4  Media File Context Menu

	4.2.3  Add Input Sources
	4.2.3.1  Add Network Media
	4.2.3.2  Add Website Input Sources
	4.2.3.3  Add NDI Input Sources


	4.3  Manage Layers
	4.3.1  Add Layers
	4.3.2  Layer Mosaic
	4.3.3  Set Layer Properties

	4.4  Build Application Environment
	4.4.1  Add Screens
	4.4.2  Add Slices
	4.4.3  Set Slice Properties
	4.4.4  Configure Link Backup

	4.5  Produce Programs
	4.5.1  Edit Programs
	4.5.2  Set Media Continuation
	4.5.3  Set Program Properties
	4.5.4  Set Program Jump
	4.5.5  Manage Program Groups

	4.6  Playback Control
	4.7  Save Projects

	5  Settings
	5.1  System Settings
	5.1.1  General
	5.1.2  Display
	5.1.3  Audio
	5.1.4  Office

	5.2  Authorization
	5.3  Hotkey Binding
	5.4  MIDI Binding
	5.4.1  Connect MIDI Keyboard
	5.4.2  Bind MIDI


	6  Help
	6.1  User Manual
	6.2  Software Updates
	6.3  About

	7  Tools
	7.1  Transcoding Assistant

	8  Graphic Card Mosaic
	8.1  Set Main Display
	8.2  Change Resolutions
	8.2.1  Set Standard Resolutions
	8.2.2  Set Custom Resolutions

	8.3  EDID Management
	8.4  Output Mosaic

	9  External Control
	9.1  Control via Event Controller
	9.1.1  Joint Control
	9.1.2  KVM Control

	9.2  Control via Stream Deck
	9.2.1  Software Obtaining and Preparations
	9.2.2  Software Configuration



